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Seeking Value in a Sea of Buzz and Jargon

Process Efficiency
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The Importance of Data (and Sensor Data) is Increasing

Device Explosion Social Networks Cheap Storage

. 100 gets you 3million
>55 billion (70+% of >2 Billion Erptims_«?nncfr’:e ?toraéé in

global population) users 30 years)

Ubiquitous Connection Inexpensive
Computing

Web traffic
2010 130 Exabyte (10 E18) 1980 10 MIPS/$
2015 1.6 ZettaByte (10 E21) 2005 10M MIPS/$
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OSlsoft has Listened to Your Needs

SWHERG CUSIOMAY «| o to be able .
“We’re looking to code and to look at data Summary of Needs:

get the data into supporting it across similar and N
tools like INCIEHNILENASYUSTY ifforent assets at Familiar tools

Spotfire" not an option” the same time” Scalability without code

Flexibility and trust

({() OSlsoft, 2016 REG'ONAL SEM'NARS © Copyright 2016 OSlsoft, LLC 4



Pl Integrators

Pl Integrator for Business Analytics
 SQL Server

Hadoop (HIVE & HDFS)

Oracle RDBMS

File

ODBC client

Pl Integrator for
Business Analytics

ntegrator for SAP HANA
SAP HANA
Smart Data Integration (SDI)

Pl Syste

Time, Event Tabular
and Asset Context
Context

Pl Integrator for Microsoft Azure
* SQL Data Warehouse

* Azure SQL

 Azure Data Lake
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The Traditional Pl System

Interfaces Pl Data Archive  PI Clients

Il

50K+ events f sec
90K tags per interface

30->300 tags
every 30 seconds

billions of values per day

200,000 or more data streams
kept forever

@ osisoft. 2016 REGIONAL SEMINARS © Copyright 2016 OSlsoft, LLC



An Alternative Data Use Model

Interfaces Pl Data Archive Pl Integrator for
-

Business Analytics

|

|

S0K+ events / sec
50K tags per interface

billions of values per day 25K events f sec
200,000 or more data streams billions of values
kept forever
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Getting Value...

Solving complex Dashboarding — visual Integration to new I.T.

problems for a fleet reporting — real time & projects and databases
mobile

Multivariate, other Drill drown, rollup The right way to bring

statistics & machine Anywhere anytime operational data to I.T.’s

learning resources
One time answers or

Big Data party...

Ty }lln : L Microsoft /
il o @ P SGlsener (ilimlon

_ ¥,

= — 8 P
: w ; ﬁ ety i | (]| e ORACLE'
- . $72316 BUSINESS INTELLIGENCE
\: x 2 TIBCo d

+
+ .
i) PowerBl iy tableau

Running models -
L
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Why? Big data ... complex problem solving

All PI Customers have a great deal

Statistical Analytics

of data.. Often too much for

This data can be complex with

many variables. Multivariable

« Identifying patterns and analysis and machine learning can

discovering problems
through statistical methods
that require large and answers to complex, big
diverse datasets

provide interesting and invaluable

questions...

Pl data is very large and complex.

This is about finding the answer to large, complex questions.

effective analysis in a spreadsheet.

Multidimensional
Business Intelligence
& Dashboards

S e

| ) AL p—
UF K[ Aal o [ FF BF o
S S Sl e
12372014 12.00.00 AM qang TR
.

—

Predictive
Statistical Modelling
& Machine Learning
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Complex Analyses Increase the Need for Deeper Integration

Complexity

Disparate assets
Interacting with assets on an individual basis

Process Optimization

Real-time & historical
Vviews across any
asset

Monitoring

Real-time visibility

* Pl ProcessBook
* Pl Coresight
* P| Datalink

* Traditional HMI
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[
Interacting with common assets as a fleet
System Optimization

Benchmarking .
Large scale multi-
Fleet-wide variate analysis
performance
comparisons

m
* Machine learning

* Bl app (e.g. Tableau, (Azure ML, R)
Spotfire, Lumira) * Pl Integrator for

* Pl Integrator for Business Analytics
Business Analytics * Pl Integrator for SAP

* Pl Integrator for SAP VANV
HANA

10
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Complexity

Applying Data to Maintenance...

Disparate assets
Interacting with assets on an individual basis

Data aware

Monitoring
Using run times

and not clock

Wait for failure
hours to

faster break & fix
schedule

Preventive
Maintenance

and inspections
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Interacting with common assets as a fleet
Predictive

Performance
Based on the

Compare current history of like
performance equipment and
metrics, including § circumstances —

vibration to build a model

expected values that predicts

failure and
triages
maintenance
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Results and ROI: Data Integration can Address Key Questions

Oil & Gas Pharmaceuticals Transmission & Dist

* What material is being =« When did the « Was wind gusty or « What product is » How are renewables
hauled? geology change? steady? being made? impacting the
* When was it raining? . : . >
o A e hellas I e . Whlch wgll was « Was the « When is the equipment?
road? being drilled? maintenance equipment empty? * Was there a voltage
. i ) i i ?
What‘ls;the grade of What .angle was the planned? o M s T violation®
the hill? drill bit? . . * What are the
« When did breaks and | duct —— b How long does this instrument when | h . her?
downtime occur? s %r?” uctlg!w‘re a:;e issue usually take to took that CEITEES ) WS
* How do driving 0 il el oSt fix? measurement?

behaviors vary by
shift?
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Why? Dashboarding

#yumies Qil (BOD): Actual v, Budget

- . Mui’giple data source views

* Automated daily reports

- Jr’*ﬂ[n_r- - Management overviews

Visual Analytics

e KPIs and metrics

¥ ¥ YT YT T T T T LWL WL LWL W W0 W 0D

Actual, 3&15, Budget

Date
#umies Gas (MCFD): Actual v. Budget

* Future Data (forecast)

%T‘f,wrﬂff\‘m‘“ {)/VJN Budget

Scheduled and Ad-Hoc Reporting

Date

* Visualizing diverse sets of
data sources to gain insights,
create reports, and improve
operations

Actual, 3&15, Budget

Don’t wait for tomorrow to explore performance today
your operational data is a click or swipe away.

Even from your mobile devices
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Result: Improved, Detailed Reporting and Analytics

Dashboard drilldowns
to detailed reports

S —

Production Refinery Regional
Summaries KPI Scorecards ........|||||m||I|||||||l|II||||||I|I|||||||||||||||||||||||||||||||||||I||m||||m e Produc?t
Inventories

Drilling Activity Reports Asset Performance Displays

@ osisoft. 2016 REGIONAL SEMINARS © Copyright 2016 OSIsoft, LLC

14



Why? I.T. Integration projects

Information systems have projects that provide enormous value —

and those can benefit from the real-time process awareness of Pl

Data Warehousing

Data. But Pl Data hasn’t been easy to integrate — until now.

% i/
ot 4 i ‘
- : JECT MANAGEMENT PROGESS G
T

E ~+—
‘31
a/a é?j

* Centralizing data from
different business systems

* More effectively analyzing
and reporting on business
and building LOB
applications

mp) Power B

®

Structured PI data in a format readily consumable by the latest I.T. tools.
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New Technology is bringing the IT and OT Worlds Together

¥
i)

| want to build predictive X g (

M

models from historical data

| want to spend less n

time on operational
reports

% '
| want to compare n oOT
my equipment

against our other sites Engmeg; > &

%:.€0

COO

“Plant Manager Infrastructure

| want to minimize

risks through data
driven decisions
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Oil and Gas
Drilling and production comparisons
~ Information distribution

Mining

Route optimization
Energy reduction
Across 300 haul trucks

Life Sciences
' Reactor comparisons
| Process scale-ups

I (1L, 3L, 10L,1kL, 10kL)

h Wﬂ | e T IR

Renewables ‘ Pl Integrator for Business Analytics et Food and Beverage =

Energy production reports is in use today! —
Wind farm comparisops {
Outlier analysis <}—/'\ v IT/ OT integration

\}_ | v’ Business intelligence and reporting

v' Data warehouse integration

L v Supporting cross-platform projects
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(Big) Data Projects: Sound Attractive ... But There are Challenges

100

S0%

64% of large enterprises plan to ., Clean &Prep
implement a big data project. 70%
85% will be unsuccessful. 50%

50%

40%
Analysis

Data cleansing and preparation tasks can take
50-80% of the development time and funds.

0%

20%

Succeed
10%

0%

Source: https://hbr.org/2014/04/the-sexiest-job-of-the-21st-century-is-tedious-and-that-needs-to-change/
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https://hbr.org/2014/04/the-sexiest-job-of-the-21st-century-is-tedious-and-that-needs-to-change/

(Big) Data Projects: Time Spent in the Wrong Areas

What data scientists spend the most time doing

® Building training sets: 3%

Cleaning and organizing data: 60%

Collecting data sets; 19%

Mining data for patterns: 9%

Refining algorithms: 4%

Other: 5%
What's the least enjoyable part of data science?

Building training sets: 10%

Cleaning and organizing data: 57%

Collecting data sets: 21%

Mining data for patterns: 3%

Refining algorithms: 4%

Other: 5%

Source: http://www.forbes.com/sites/gilpress/2016/03/23/data-preparation-most-time-consuming-least-enjoyable-data-science-task-survey-says/#5481f6 03775
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http://www.forbes.com/sites/gilpress/2016/03/23/data-preparation-most-time-consuming-least-enjoyable-data-science-task-survey-says/#5481f6037f75

Cleaning & Preparing Sensor Data: It's Challenging

. Comm Failure
Speed I |

1
1
| |
1 1
.' c:o.cioo . Ao 00 80 Differen
1 1 1
: :
1
|

‘“inon;n«

Spike /
Out of Range

: Additional
™~ Measure

1
03:40 | 03:50
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Pl Integrators Let You Clean and Prepare Pl System Data

for your business intelligence tools,
data warehouses, and

6"’* data lakes

TIBC® Spotfire
Cleanse
Data quality m Power BI
@ Augment COCAAee
. WU nD
Aggregation Analyze
i .
Assets Shape A rableay
Events Model Maosoit
oae K% SQL Server
Transmit ,
Normalization ‘@hadggp

Clean & Prepare
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Pl Integrator for Business Analytics - “Select Data”

* Intuitive way to

create tabular Select Data > Modify View > Publish Noxt
H ¢ ) Source Assets i Asset Shape Matches
content in “PI
’ Server CHERTLER64305 T, Shapes Found 29 Matches
VI eWws Database Compressors @ Compressor Vs @ Compressor-023
N @ Compressor-304

& Differential Pressure
@ Compressor-340

# Gas Flow e @ Compressor-356

o Req U i res AF 4 @ Gastran taaatet = @ Compressor-432

4 Edit Filters (@ Compressor-567

Hierarchy © unto

[} Asset Name @ unitol
€ Unitoz

e Select AF Elements | compressor2s Epe

@ Unito3
and Attributes hsset Template [Compressor v e

Unit04
(*) Add Filter © n?
@ unitos

e Scale up leveraging : @ unios

@ Unitos

name, hierarchy, or _ © untos

€ Unito7

category © unior

@ Unito7
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Pl Integrator for Business Analytics - “Modify View”

Compressor Analysis

® Column Details

* SeIeCt any tlme Select Data > Modify View > Publish Name

range and interval —— T E— startTime emm ]
6 Columns 0 Row Filters Rzﬁliiﬁ:‘:lues heset Name 1o Defau

Data Content @

Compressor | LocalTime Differential Pressure Gas Flow |
° Ad d coO I umns fO r Unito1 2011-10-01 00:00:00 93.3822 100.6735 Model A
. Unito1 2011-10-01 00:01:00 9336484 1006739 Model A
roper a g g reg atl n g Unito1 2011-10-01 00:02:00 9334747 100.6742 Model A
Pl Syste m d a‘ta unito1 2011-10-01 00:03:00 93.33011 100.6746 Model A
unito1 2011-10-01 00:04:00 9331274 100.675 Model A
Unito1 2011-10-01 00:05:00 9329539 100.6754 Model A
° A d d CcO I umns f or Unit01 2011-10-01 00:06:00 93.27802 100.6758 Model A e
. Unito1 2011-10-01 00:07:00 93 26066 100.6761 Model A e G B
common t| me an d Unito1 2011-10-01 00:08:00 9324329 1006765 Model A
d at e fu N Ct| ONs Unito1 2011-10-01 00:09:00 9322593 100.6769 Model A
unito1 2011-10-01 00:10:00 93.20856 100.6772 Model A
unito1 2011-10-01 00:11:00 93.1912 100.6776 Model A
Unito1 2011-10-01 00:12:00 93.17384 100.678 Model A
Unito1 2011-10-01 00:13:00 93.15647 100.6784 Model A
Unito1 2011-10-01 00:14:00 93.13911 100.6787 Model A
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Pl Integrator for Business Analytics - “Publish”

* Select targeted
endpoint “Pl View”,
MS SQL, text file, E—
more to come.... O Run Once | e

Timeframe and Interval

Select Data > Modify View > Publish

Target Configuration Summary

® Run on a Schedule
« Your Start Time is Saturday, October 1,

. First Run 201 12:00-:00 AM
e Publish once or on E 3 Yo T = T oember,

+ Your Time Interval gets an interpolated
a scheduled bases o | (EE=E essrament vey bt
S0 Mo Tu We Th Fr  Sa

25 26 27 28 29 30 H
a8 9 o 1 12 13 14
% 1B 17 1|8 19 20 21
22 23 24 25 26 27 28

23 30 1 2 3 4

Hour Minute Second

0o|v] 0o[v| 00)v|
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Let’s See This in Action!

Publishing Building Energy Consumption
for 67 Buildings to SAP HANA
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@’:'mmm:ﬁ‘w\. D] 4 || 42| XY Pi Coreht “Fecticky Usage v | [ P4 rtograroe for sap wervs % | el Biintoniator for saprana ||

g
Pacisply [8) P Corosight 2 Pl Coresight Admin 2 | PTWed APT & | Search Dtabases

= [# i rkogratoe for Sap Har B P1 5. for 58P Hava ad=n @ operational Intedgence = D...

= Create Asset View o Create Event View & modity View
B weth Yooy = . Moty edking e

] | Nama Run Status Type Run Made Start Time End Tima Last Run Time l"‘
& Manufacturer Companson Pubished Asset Once 1-dec.2015 1-apr-2016 Hi5A1611:00 PM ‘
@  NewPublication Pubdishing Assel Once 1-jan-2013 1-mar-2013 S/16M610.17 PM |
& Compressors Pl View Published Asset Once 1-Jui-2014 1-4ul-2015 519716 4:54 PM
& Ol Midstream Analysis Published Asset Once 142014 1-uiD2015 516 11:08 PM

Compressors Pl View 2 Nol Yet Published Assel Once 1-jul-2014 1§ul-2015 Never
&  Solar Array Pubikation Published Asset Once 1-jan-2016 1-mar-2016 S'9/16 3:38 PM

Solar Array 2 Not Ye! Published Asset Onre ~5h - Never

—m

Overview Log Security

& Run Status Publishing 76% Publish Actions Search Shape

[= == == -a A e wa S e = S = e )
Assel Shape

4 (@ Fedenal

Pl AF Database Utilities Analysis _ =l 15t Cnar. of Suiiding Code
Slop
Publish Target SAP nd Char. of Dullding Code

Vicw Name NewPublication 1 fesume

Building Template

View Type Asset & Aclive Energy Defvered
| Update Data

Run Mode Once

Last Run Time S5A6/16 1017 PM =] Element Name

Your Start Time is 1jan-2013 =] Eloment Type

Your End Time is 1mar-2013

Sample Frequency 30 minutes

i Pasenl Type

l‘}startl .:A Ej W}v @\\m'o.mmnesu.l @mnleudwmrs". ﬁswww«h'n'm...l




Operational Reporting & Analysis Architecture

‘Tableau Spotfire MSFTBI

Visualization & ‘ ... All Bl tools that ’
Analytics support ODBC

“l want to analyze
operations data
stored in the PI

System using
modern Bl tools!”

Data Preparation and
Integration Layer

System of Record
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Enterprise Data Warehouse Architecture

“I need to fit

Vlsxallzla:.lon & L Tableau } L Spotfire l SAS M MSIFT M A CT.Stcfcl.n } operational data
N, Ny o Do o o 2 JApplications into my existing
Enterprise Data company IT

Warehouse / Data Oracle DW, SQL Server, Teradata Hadoo%giD information
Mart / Data Lake

Pl Integrator
Data Preparation and for Bufiness Custom or 3" Party Data Management
Integration Layer and ETL

System of Record Pl Server

architecture!”

ERP HR
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Pl Integrator for SAP HANA Architecture

SAP HANA HANA Studio
HANA SDA % @ =

Linux ' SAP Lumira, VORA, S4, etc.

SAP DP Agent SAP HANA IoT Connector by DLr;iaﬁon
Option 1 Linux / Windows (Al Pl JDBC OSlsoft Doa A  Option2
Java) (via SDA) schema

Pl Integrator Framework
Windows Web Ul Shape Designer Security REST Layer

Pl Server
Pl View

DEE:] Framework (AF)

Archive ;
Windows Microsoft SQL Full platform coverage for all

data integration scenarios!
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Soon... Pl Integrator for Azure SQL Datawarehouse

DATA SOURCES PREPARE INGEST ANALYZE PUBLISH CONSUME

Pl System

|
|
Azure SQL 1 Machine Learning | Azure 5Q|-
|
|

|
[
|
: ||
I | Data Warehouse
; Data Warehouse I
L ______ e e e e Je L___ ) Power BI
[ 1 I
: Predictions as Future Data (to Pl 2015) 1
|
[
|
[
|
[
|
1

1

|

I | |

< Azure Data Factory (Orchestration) >: Web/LOB Dashboards

I I

1

1

1

On Premise
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Getting Value...

Solving complex Dashboarding — visual Integration to new I.T.

problems for a fleet reporting — real time & projects and databases
mobile

Multivariate, other Drill drown, rollup The right way to bring

statistics & machine Anywhere anytime operational data to I.T.’s

learning resources
One time answers or

Big Data party...

Ty }lln : L Microsoft /
il o @ P SGlsener (ilimlon

_ ¥,

= — 8 P
: w ; ﬁ ety i | (]| e ORACLE'
- . $72316 BUSINESS INTELLIGENCE
\: x 2 TIBCo d

+
+ .
i) PowerBl iy tableau

Running models -
L
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Move the Needle with Pl Integrators

e Start the conversation!
* Could a colleague make a better
decision with data you see daily?

* What business intelligence tools .

could you leverage further?

Pl Integrator for Business Analytics
Pl Integrator for SAP HANA

L ] Pl Integrator for Microsoft Azure
* Visit YouTube or osisoft.com to see

which Pl Integrator works for you
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Contact Information

Martin Bryant
MBryant@osisoft.com

Field Service Engineer
OSlsoft, LLC
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Questions

Please wait for the microphone
before asking your questions

State your
name & company

Q) ossot. 2016 REGIONAL SEMINARS

Please remember to...

Complete the Survey
for this session

REGIONAL SEMINAR

30Tt
Safeco Fi

osli

ield - Seattle, WA - Septemb

Digttal e
ne iew Vision, New Display Editor, New Look and Feel —
. Moni nd Performance of Grid-Scale Energy Storage
Sys Technologies
4. Using P1 Integrators to Improve the our P Data- OSisoft
Pl Asset Framework Ties Together Enterprise OEE for Clearwater Paper

s
Clearwater Paper
6. Solving Business Initiatives with the PI System - OSisoft
7. Pl Analytics and Coresight for Business Process Improvement — Avist
eeq helps customers get even more value from their OSisoft Pl System —

o o o
8. S
st o o o
9. What's Really Going on with your Beer's Fermentation? ~ Deschules
Brewery a o =] a
[Qualiyofseminar ]}
Poor Excellent  NIA
ts o a (=] a
o o o o
o a =] a

Presentation topics meeting your needs or interest
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Pl Integrator for Business Analytics

©Spotfire’

TIBCO Software

@ HARMONY

B Microso

o ft
< SQLServer

Reporing

: .@hadmap

The Pl Integrator for Business Analytics fully realizes the PI
infrastructure goal by providing peerless real-time & deep historical
Pl process data to enterprise “big data” dash-boarding, integration,
analysis and data scientist tools with easy configuration and
performance.
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Pl Integrator For Business Analytics

* No programming or queries - browser based configuration

* Integrated to Pl AF - uses templates as schemas

* Rest Model Accessed with ODBC driver
* New fast Pl ODBC Driver & Pl Data Access Server

* Windows Integrated security with delegation (Kerberos)

* Updates for new data on a schedule
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Pl Integrator For Business Analytics

Integrator Targets:

* Microsoft SQLServer
 Hadoop

* QOracle

* Ascii files/CSVs

* SAP Hana (from SAP)

* Microsoft SQL Datawarehouse for Azure (cloud based)
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Pl Integrator For Business Analytics

e Supports Pl Event Frames

* Time Sampling analogous to PI Datalink

* Data cleansing (nulls/errors), row filtering (by value, etc..),
data typing (string/numeric) for each column

* Aggregations supported — calculate averages, totals for

intervals.
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O LSO B Business Analytics

Compared to previous OSIsoft data access technologies:
* Much easier to learn (2 hrsinstead of 1 day - configured not coded)
no coding — no code generators
* Much higher performing (many millions of rows instead of <100K)
~ 25K outbound events per second
* Integrates to key 215t century technologies
endorsed by major tech players and many large companies

More secure
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What’s new?

Is this merely a new product built by OSIsoft?
or does it fit into a larger perspective?

Relational database technology is changing

Technology is changing — new opportunities from “Big Data”
and internet of things
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Relational database technology is changing

SQL — the end of an era

* Tablular. Not object oriented
* File oriented. Not scalable

e Security Challenges

SQL and relational / tabular technologies are not adequate to today’s data.
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Relational database technology is changing

Web Services — not adequate for big data

Too slow for big data

Transmission and query — but no storage

Programming — but no client tools

(@ osisoit. 2016 REGIONAL SEMINARS cOpy,—igmgmgosSoﬁ, e

Security Challenges




Relational database technology is changing

Best of both worlds technologies required:
REST (representational state transfer) technologies

* Web interface and transport — designed for the internet
* Performance — designed for memory resident scalability
e Standard data formats including binary formats

* Object oriented

e Secure in the current cross platform environment
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Impact of Big Data / Internet of Things Technology
Impact of Social Media

Google, Facebook, and other social media sites have generated massive
amounts of data..

This may not seem immediately relevant to industrial applications,

But it has driven new search engine and database technologies..

And it has resulted in self-service clients to do analysis
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Impact of Big Data / Internet of Things Technology
Impact of Internet of Things

As computing becomes less expensive...
Every “thing” gets a computer — refrigerators, fitness wristbands, cars,
drones, mobile devices,

and new industrial devices too
These devices are not organized and
concentrated pyramidaly
and that is demanding and providing new
secure data communications and
database technology.
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The Big Data Landscape

From: http://www.bigdatalandscape.com/
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http://www.bigdatalandscape.com/

Why? Big data ... complex problem solving

Statistical Analytics

All Pl Customers have a great deal of
data.. Often too much for effective

analysis in a spreadsheet. This data

can be complex with many variables.

* Identifying patterns and Multivariable analysis and machine
discovering problems
through statistical methods

that require large and invaluable answers to complex, big
diverse datasets

learning can provide interesting and

questions...

Pl data is very large and complex.

This is about finding the answer to large, complex questions.

Q) ossot. 2016 REGIONAL SEMINARS

* How are
renewables
impacting the grid?

* What kind of grid
components are
associated with
voltage violations?

* What is the impact
of changing
weather?
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Complex Analyses Increase the Need for Deeper Integration

. I
Disparate assets Interacting with common assets as a fleet

Interacting with assets on an individual basis .. .
° System Optimization

Benchmarking Large scale multi-

Process Optimization variate analysis

Fleet-wide

TR : : : performance
Monitoring Real-time & historical comparisons

Vviews across any
Real-time visibility asset

* Machine learning

* Bl app (e.g. Tableau, (Azure ML, R)
Spotfire, Lumira) * Pl Integrator for
" * Pl Integrator for Business Analytics
7 Uil =il 2 P PDEEsEEepk Business Analytics * Pl Integrator for SAP

2 EUCEIESIdR « Pl Integrator for SAP HANA
* Pl Datalink HANA

Complexity
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Enabling Analytics for Operational Intelligence

Real-Time Decision Analysis Retrospective & Predictive Analysis

Pl Integrator for
Business Analytics

s ,H A=) ‘H‘

Time and Event
Trending & Awareness

Multidimensional
Business Intelligence
& Dashboards

Specialized Models
Simulation & Optimization

(1500
s | ol
A FAY
- APpp * kh A NP YR
1412#3@{!?’1;—:’ — 731 + S} Time’ Event Tabular S A i e

and Asset Context
Context

Predictive
Statistical Modelling
& Machine Learning

Descriptive
Condition & Performance
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Why? I.T. Integration projects

Information systems have projects that provide enormous

value — and those can benefit from the real-time process

Data Warehousing

awareness of Pl Data. But Pl Data hasn’t been easy to

integrate — until now. @
. \ Y

oo vt £3 e i = =

* Centralizing data from
different business systems

* More effectively analyzing
and reporting on business
and building LOB
applications

ul]] Power BI

Structured PI data in a format readily consumable by the latest I.T. tools.
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New Technology is bringing the IT and OT Worlds Together

¥
i)

| want to build predictive X g (

M

models from historical data

| want to spend less n

time on operational
reports

% '
| want to compare n oOT
my equipment

against our other sites Engmeg; > &

%:.€0

COO

“Plant Manager Infrastructure

| want to minimize

risks through data
driven decisions

y
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No single purpose data pools — data lakes that are:

* Reusable & Flexible

 Vetted & Maintained

 Secure

* |ntegrated with data from other sources
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Why? Dashboarding

Industrial companies are replacing periodic row and column reports (day,

shift, etc..) with dynamic web-based dashboards — and they are exploring

Visual Analytics them from their phones and mobile devices. They are combining the near
real time operational data with financial and administrative data for the

comprehensive view of the immediate road ahead.

°

. b
. ﬁ'-.'r?’-":’.—:

[N -~ LU

n;

* Visualizing diverse sets of ,
data sources to gain insights, 4
create reports, and improve
operations

ren i R e |

Don’t wait for tomorrow to explore performance today

II ($7.39M)
$723%6

your operational data is a click or swipe away.

Even from your mobile devices
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Use Case: Management Summaries

Saumies Oil (BOD): Actual v. Budget

- S T o L T Do Do oo o oo
mmmmmmmmmmmmmmmmmmmm

#4smmns Gas (MCFD): Actual v. Budget

Actual, 3&15, Budget

Date

Q) ossot. 2016 REGIONAL SEMINARS

JLT]M“WMNJ\} e

— Color by
m— I ® Actual

< — @ 3315

g - Budget

- IV =

o3 - - —

g P Ppatebd

]

T ¥ Y % T T T T T W W WL WL W WL W W WL W W

< PR R R EEEEEEEEES

Color by
@ Actual
® 3815
() Budget

Automated daily reports
Multiple data source views
Management overviews
KPIs and metrics

Rollups by business unit
Future Data (forecast)
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Result: Improved, Detailed Reporting and Analytics

Dashboard drilldowns
to detailed reports

S —

Production Refinery Regional
Summaries KPI Scorecards ........|||||m||I|||||||l|II||||||I|I|||||||||||||||||||||||||||||||||||I||m||||m e Produc?t
Inventories

Drilling Activity Reports Asset Performance Displays
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Big Data Projects Sound Easy... But there are Complications!

100%:
64% of large enterprises plan to 50%
implement a big data project. 0%

0%

Prep

85% will be unsuccessful.

B0%
50%
40%

30%

Analysis

Data cleansing and preparation tasks can take
50-80% of the development time and funds

20%

10%

0%

https://hbr.org/2014/04/the-sexiest-job-of-the-21st-century-is-tedious-and-that-needs-to-change/

@ osisoft. 2016 REGIONAL SEMINARS © Copyright 2016 OSlsoft, LLC 10




OSlsoft has Listened to Your Needs

SWHERG CUSIOMAY «| o to be able .
“We’re looking to code and to look at data Summary of Needs:

get the data into supporting it across similar and N
tools like INCIEHNILENASYUSTY ifforent assets at Familiar tools

Spotfire!" not an option! the same time!” Scalability without code

Flexibility and trust
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OSlsoft’s Solution Lets You Prepare and Deliver Process Data

to any Visualization Tool

or Analysis database
via the ODBC standard

mp) Power Bl @HARMONY

CLEANSE

AUGMENT SHAPE

nrj:-} +ableauw Jsas
m—p  Clk@  SOLsener
TRANSMIT o
rﬂl" AL’
WS @ memsq|l

ORACLE' i@hadﬂﬂlﬂ

BUSINESS INTELLIGENCE

@ osisoft. 2016 REGIONAL SEMINARS © Copyright 2016 OSlsoft, LLC



Operational Reporting & Analysis Architecture

‘Tableau Spotfire MSFTBI

Visualization & ‘ ... All Bl tools that ’
Analytics support ODBC

“l want to analyze
operations data
stored in the PI

System using
modern Bl tools!”

Data Preparation and
Integration Layer

System of Record
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Enterprise Data Warehouse Architecture

“I need to fit

Vlsxallzla:.lon & L Tableau } L Spotfire l SAS M MSIFT M A CT.Stcfcl.n } operational data
N, Ny o Do o o 2 JApplications into my existing
Enterprise Data company IT

Warehouse / Data Oracle DW, SQL Server, Teradata Hadoo%giD information
Mart / Data Lake

Pl Integrator
Data Preparation and for Bufiness Custom or 3" Party Data Management
Integration Layer and ETL

System of Record Pl Server

architecture!”

ERP HR
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Tips - Meta Data & Hierarchy

* You can't roll up and you
can’t drill down without
hierarchy

 And Meta-data (installation
date, mode, long/lat) is
where the slicers for great
Bl comes from
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Tips - Joins

Using this technolody — Joins are done in the client

We had pretty clear naming of our elements —
f you are having problems with joining to unique objects — two hints

One to many joins — it’s easier to join if one database has only one record
per unique item (one per turbine or transformer or substation — you can use
this as an index and join other tables to it and they’ll transfer those
relationships through it.

If your naming is not very unique — you can insert the ElementID in as an
attribute and join on that. We did that in this example even though we
didn’t need to.
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Tips - Categories

If you have multiple tables coming from
the same element — you can predefine
what you want to put in each table by
marking them with categories...

Sort by category in the integrator and pull
the whole group into your attribute /
column selection.
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Tips - Aggregates Z

The default method for getting data into a column
for the integrator is interpolation

The fastest method is “last recorded value”

But often the best is an average ..

Don’t be shy about the average
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Takeaways

As always — developments in the larger technology world (Big
Data, the Internet of Things) are producing innovations in
database and communications technology

At OSlsoft — we are not just aware of this — we are embracing
it...

With technologies that use new
standards and methods but are
consistent with your decades of
history...
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Takeaways Pl Integrator For Business Analytics

* No programming or queries (based on Pl AF)

* Writes to appropriate Big Data databases (Hadoop, SAP)
* Cleanse, Filter, Shape your data — and it will update

* Secure

Compared to previous OSlsoft data access technologies:
* Much easier to learn and use

* Much higher performing
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Use Cases

Production Reporting
— More detailed view into energy, oil, metals

Alerting and Customer Intimacy

— Integrate detailed production data with CRM data to alert on outages
and meet customized SLA requirements

Regulatory Compliance

— Keep product genealogy data on hand for products to deal with
regulatory requests

Root Cause Analysis
— Discover patterns related to equipment failure or low quality product

@ osisoft. 2016 REGIONAL SEMINARS © Copyright 2016 OSlsoft, LLC 82



Pl Integrator for
SAP HANA

Devices & * *
Gateways

®

Pl Server(s)

a
<
@ -
w
s
@ QO
t 35
@
= E
(=
:LL
L)
53
@z
QO
=
]
w0
o

Full platform coverage for all
data integration scenarios
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Data
Access
Pattern

Data Pulls
(Federated)

Product/
Feature
Roadmap

SAP IoT Connector
(Smart Data Access)

Databases and

Applications
HANA Database
: Smart Data
Streaming
Platform Edition Vora
EEEN S4
1l Eic.

SAP HANA Cloud
Platform
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Released: Pl Integrator for Business Analytics & SAP Hana

Pl System Visual Analytics

) +
Pl View Ecel whitableau
Pl ODBC — X . .
©Spotfire’ T
Thx Xk ko x P e, COGNGS qlikView
3 |x X X % % X X BCO 20LMILE
4 % X X X X X X
5 (% kd X X X kd ks
e % X X X X X X
7 |x X X X X X X

Statistical Analytics
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Enabling Analytics for Operational Intelligence

Real-Time Decision Analysis Retrospective & Predictive Analysis

Pl Integrator for
Business Analytics

s ,H A=) ‘H‘

Time and Event
Trending & Awareness

Multidimensional
Business Intelligence
& Dashboards

Specialized Models
Simulation & Optimization
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1412#3@{!?’1;—:’ — 731 + S} Time’ Event Tabular S A i e

and Asset Context
Context

Predictive
Statistical Modelling
& Machine Learning

Descriptive
Condition & Performance

@ osisoft. 2016 REGIONAL SEMINARS © Copyright 2016 OSisoft, LLC SO



Use Case: Management Summaries

Saumies Oil (BOD): Actual v. Budget

- S T o L T Do Do oo o oo
mmmmmmmmmmmmmmmmmmmm

#4smmns Gas (MCFD): Actual v. Budget

Actual, 3&15, Budget

Date
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JLT]M“WMNJ\} e

— Color by
m— I ® Actual

< — @ 3315

g - Budget

- IV =

o3 - - —

g P Ppatebd

]

T ¥ Y % T T T T T W W WL WL W WL W W WL W W
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Color by
@ Actual
® 3815
() Budget

Automated daily reports
Multiple data source views
Management overviews
KPIs and metrics

Rollups by business unit
Future Data (forecast)
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